iVMS-4200 Client Software

User Manual (V2.0.0)

UD.6L0201D1034A01
Chapter 1 Overview .................................................................................................................. 3
  1.1 Description ......................................................................................................................... 3
  1.2 Running Environment ......................................................................................................... 3
  1.3 Function Modules .............................................................................................................. 3
  1.4 Updates Instruction .......................................................................................................... 5
Chapter 2 Live View .................................................................................................................. 7
  2.1 User Registration and Login ............................................................................................ 7
  2.2 Adding the Encoding Device ........................................................................................... 8
    2.2.1 Adding Online Devices ............................................................................................... 8
    2.2.2 Adding Devices Manually ......................................................................................... 10
    2.2.3 Adding Devices by IP Segment ................................................................................. 10
    2.2.4 Adding Devices by IP Server .................................................................................... 11
    2.2.5 Adding Devices by HiDDNS ...................................................................................... 12
  2.3 Group Management .......................................................................................................... 13
  2.4 Basic Operations in Live View ......................................................................................... 15
    2.4.1 Starting and Stopping the Live View .......................................................................... 17
    2.4.2 Auto-switch in Live View .......................................................................................... 19
    2.4.3 PTZ Control in Live View ......................................................................................... 20
    2.4.4 Manual Recording and Capture ................................................................................ 22
    2.4.5 Instant Playback ........................................................................................................ 25
    2.4.6 Other Functions in Live View .................................................................................... 27
Chapter 3 Remote Record Schedule Settings and Playback ................................................ 28
  3.1 Remote Recording ............................................................................................................ 28
    3.1.1 Recording on Storage Devices on the DVRs, NVRs, or Network Cameras ............... 28
    3.1.2 Recording on Storage Server .................................................................................... 31
  3.2 Remote Playback .............................................................................................................. 33
    3.2.1 Normal Playback ........................................................................................................ 34
    3.2.2 Event Playback .......................................................................................................... 35
    3.2.3 Synchronous Playback .............................................................................................. 36
Chapter 4 Event Management ................................................................................................. 38
  4.1 Configuring Motion Detection Alarm .............................................................................. 38
  4.2 Configuring Tampering Alarm .......................................................................................... 41
  4.3 Configuring PIR Alarm ...................................................................................................... 42
  4.4 Configuring Video Loss Alarm ........................................................................................ 43
  4.5 Configuring Alarm Input Linkage ..................................................................................... 44
  4.6 Configuring Device Exception Linkage ............................................................................ 45
  4.7 Viewing Alarm and Event Information ............................................................................ 46
Chapter 5 E-map Management ............................................................................................... 48
  5.1 Adding an E-map .............................................................................................................. 48
  5.2 The Hot Spot Function .................................................................................................... 50
    5.2.1 Adding Hot Spots ........................................................................................................ 50
    5.2.2 Modifying Hot Spots .................................................................................................. 51
    5.2.3 Previewing Hot Spots ................................................................................................. 52
5.3 The Hot Region Function................................................................. 52
  5.3.1 Adding Hot Regions .............................................................. 52
  5.3.2 Modifying Hot Regions .......................................................... 53
  5.3.3 Previewing Hot Regions ........................................................ 54
Chapter 6 Log Management............................................................ 55
Chapter 7 Account Management and System Configuration .................. 57
  7.1 Account Management ............................................................... 57
  7.2 System Configuration .............................................................. 58
    7.2.1 General Settings .............................................................. 59
    7.2.2 File Saving Path Settings ................................................... 60
    7.2.3 Keyboard and Joystick Shortcuts Settings ............................. 61
    7.2.4 Alarm Sound Settings ....................................................... 61
    7.2.5 Email Settings ................................................................. 62
Chapter 8 Forwarding Video Stream through Stream Media Server ............ 63
  8.1 Adding the Stream Media Server ................................................. 63
  8.2 Adding Cameras to Stream Media Server to Forward Video Stream .... 64
Chapter 9 Decoding and Displaying Video on Video Wall ...................... 65
  9.1 Adding the Decoding Device ..................................................... 65
  9.2 Configuring Video Wall Settings ............................................... 66
  9.3 Displaying Video on Video Wall ............................................... 67
Chapter 10 Web Browsing .................................................................. 68
  10.1 Login ...................................................................................... 68
  10.2 Device Management ............................................................... 69
  10.3 Live View .............................................................................. 73
  10.4 Playback ............................................................................... 77
  10.5 Account Management ............................................................. 80
  10.6 System Configuration ............................................................. 81
Troubleshooting .............................................................................. 82
Chapter 1 Overview

1.1 Description

iVMS-4200 is a versatile video management software for the DVRs, NVRs, IP cameras, encoders decoders, etc. It provides multiple functionalities, including real-time live view, video recording, remote search and playback, file backup, etc., for the connected devices to meet the needs of monitoring task. With the flexible distributed structure and easy-to-use operations, the client software is widely applied to the surveillance projects of medium or small scale. This user manual describes the function, configuration and operation steps of iVMS-4200 software. To ensure the properness of usage and stability of the software, please refer to the contents below and read the manual carefully before installation and operation.

1.2 Running Environment

Operating System: Microsoft Windows 7/Windows 2008(32/64-bit operating system), Windows 2003/Windows XP(32-bit operating system)
CPU: Intel Pentium IV 3.0 GHz or above
Memory: 1G or above
Display: 1024*768 or above

Notes:
- For high stability and good performance, these above system requirements must be met.
- The software does not support 64-bit operating system; the above mentioned 64-bit operating system refers to the system which supports 32-bit applications as well.

1.3 Function Modules

Control Panel of iVMS-4200:
### Menu Bar:

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Captured picture</td>
<td>Search and view the captured pictures stored on local PC.</td>
</tr>
<tr>
<td>Open Video File</td>
<td>Search and view the video files recorded on local PC.</td>
</tr>
<tr>
<td>Open Log File</td>
<td>View the backup log files.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the iVMS-4200 client software.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch User</td>
<td>Switch the login user.</td>
</tr>
<tr>
<td>Import System Config File</td>
<td>Import client configuration file from your computer.</td>
</tr>
<tr>
<td>Export System Config File</td>
<td>Export client configuration file to your computer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1024*768</td>
<td>Display the window at size of 1024*768 pixels.</td>
</tr>
<tr>
<td>1280*1024</td>
<td>Display the window at size of 1280*1024 pixels.</td>
</tr>
<tr>
<td>1440*900</td>
<td>Display the window at size of 1440*900 pixels.</td>
</tr>
<tr>
<td>1680*1050</td>
<td>Display the window at size of 1680*1050 pixels.</td>
</tr>
<tr>
<td>Full Screen</td>
<td>Display the window in full screen.</td>
</tr>
<tr>
<td>Control Panel</td>
<td>Enter Control Panel interface.</td>
</tr>
<tr>
<td>Main View</td>
<td>Open Main View page.</td>
</tr>
<tr>
<td>Remote Playback</td>
<td>Open Remote Playback page.</td>
</tr>
<tr>
<td>E-map</td>
<td>Open E-map page.</td>
</tr>
<tr>
<td>Auxiliary Screen Preview</td>
<td>Open Auxiliary Screen Preview window.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Management</td>
<td>Open the Device Management page.</td>
</tr>
<tr>
<td>Event Management</td>
<td>Open the Event Management page.</td>
</tr>
<tr>
<td>Record Schedule</td>
<td>Open the Record Schedule page.</td>
</tr>
<tr>
<td>Account Management</td>
<td>Open the Account Management page.</td>
</tr>
<tr>
<td>Log Search</td>
<td>Open the Log Search page.</td>
</tr>
</tbody>
</table>
The iVMS-4200 client software is composed of the following function modules:

The Main View module provides live view of network cameras and video encoders, and supports some basic operations, such as picture capturing, recording, PTZ control, etc.

The Remote Playback module provides the search, playback, export of record files.

The E-map module provides the displaying and management of E-maps, alarm inputs, hot regions and hot spots.

The Device Management module provides the adding, modifying and deleting of different devices and the devices can be imported into groups for management.

The Event Management module provides the settings of arming schedule, alarm linkage actions and other parameters for different events.

The Record Schedule module provides the schedule settings for recording.

The Account Management module provides the adding, modifying and deleting of user accounts and different permissions can be assigned for different users.

The Log Search module provides the query of system log files and the log files can be filtered by different types.

The System Configuration module provides the configuration of general parameters, file saving paths, alarm sounds and other system settings.

The function modules are easily accessed by clicking the navigation buttons on the control panel or by selecting the function module from the View or Tool menu.

You can check the information, including current user, network usage, CPU usage, memory usage and time, in the upper-right corner of the main page.

### 1.4 Updates Instruction

Multiple newly-designed functions are offered in the latest iVMS-4200 client software. You can get a brief view of the updates instruction from the following contents.
- **Embedded Web Server**
  With the embedded web server, iVMS-4200 client can be accessed via the web browser. And it provides the functionalities of live view, playback, device management, account management, system configuration, etc.

- **User-friendly Wizard for Operation Guide**
  iVMS-4200 client offers a user-friendly wizard and it introduces some basic operations of the software, such as adding device, importing device to group, configuring record schedule, etc.

- **Different View Modes**
  Different view modes are supported in the live view or playback process. You can play the video in default view mode or in custom view mode. The custom view can be customized as desired.

- **Camera Linkage for Tampering Alarm/Video Loss Alarm**
  Enable the alarm triggered pop-up image function. When tampering alarm or video loss alarm occurs, the image from the linked camera will pop up for notification.

- **Offline Device Adding**
  The offline device can also be added to the client with the required information input. When the device comes online, the software will connect it automatically.

- **Alarm Input Hot Spot**
  Not only the cameras, but also the alarm inputs can be added to the E-map as hot spots. The alarm input hot spots can detect the conditions of the surveillance scenario and give the alarm information.
Chapter 2 Live View

2.1 User Registration and Login

For the first time to use iVMS-4200 client software, you need to register a super user for login.

Steps:
1. Input the super user name and password.
2. Confirm the password.
3. Optionally, check the checkbox Enable Auto-login to log in the software automatically.
4. Click Register. Then, you can log in the software as the super user.

Notes:
- A user name cannot contain any of the following characters: / \ : * ? “ < > |
- The password cannot be empty and the length of the password should be no less than six characters.

When opening iVMS-4200 after registration, you can log in the client software with the registered user name and password.

Steps:
1. Input the user name and password you registered.
2. Optionally, check the checkbox Enable Auto-login to log in the software automatically.
3. Click Login.

After running the client software, a wizard will pop up to guide you to add the device and do some basic settings.
2.2 Adding the Encoding Device

**Purpose:**
After running the iVMS-4200, devices including network cameras, video encoders, DVRs, NVRs, should be added to the client for the remote configuration and management, such as live view, playback, alarm settings, etc.

Perform the following steps to enter the Encoding Device Adding interface:

1. Click the icon on the control panel, or click **Tools** -> **Device Management** to open the Device Management page.
2. Click the **Server** tab.
3. Click **Encoding Device** to enter Encoding Device Adding interface.

You can add the device in the following ways:
- By detecting the online devices, see Section 2.2.1 Adding Online Devices.
- By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
- By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
- By IP Server, see Section 2.2.4 Adding Devices by IP Server.
- By HiDDNS, see Section 2.2.5 Adding Devices by HiDDNS.

### 2.2.1 Adding Online Devices

**Purpose:**
The active online devices in the same local subnet with the client software will be displayed on a list. You can click the **Refresh Every 15s** button to refresh the information of the online devices.

**Steps:**
1. Select the devices to be added from the list.
2. Click **Add to Client** to open the device adding dialog box.
3. Input the required information.
   - **Nickname:** Edit a name for the device as you want.
   - **Address:** Input the device’s IP address. The IP address of the device is obtained automatically in
this adding mode.

**Port:** Input the device port number. The default value is 8000.

**User Name:** Input the device user name. By default, the user name is `admin`.

**Password:** Input the device password. By default, the password is 12345.

4. Optionally, you can check the checkbox **Export to Group** to create a group by the device name. All the channels of the device will be imported to the corresponding group by default.

5. Click **Add** to add the device.

![Add Device](image)

Click **Add All**, input the user name and password, and you can add all the online devices to the client software.

![Add All Devices](image)

Select the device from the list, click **Modify Netinfo**, and then you can modify the network information of the selected device.

Select the device from the list, click **Restore Default Password**, and then you can restore the default password of the selected device.
2.2.2 Adding Devices Manually

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select IP/Domain as the adding mode.
3. Input the required information.
   - Nickname: Edit a name for the device as you want.
   - Address: Input the device’s IP address or domain name.
   - Port: Input the device port number. The default value is 8000.
   - User Name: Input the device user name. By default, the user name is admin.
   - Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All the channels of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

![Add Device Dialog Box]

2.2.3 Adding Devices by IP Segment

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select IP Segment as the adding mode.
3. Input the required information.
   - Start IP: Input a start IP address.
   - End IP: Input an end IP address in the same network segment with the start IP.
   - Port: Input the device port number. The default value is 8000.
   - User Name: Input the device user name. By default, the user name is admin.
   - Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device IP. All the channels of the device will be imported to the corresponding group by default.
5. Click Add, and the device of which the IP address is between the start IP and end IP will be added.
to the device list.

![Device Adding Dialog Box](image)

### 2.2.4 Adding Devices by IP Server

**Steps:**

1. Click **Add Device** to open the device adding dialog box.
2. Select **IP Server** as the adding mode.
3. Input the required information.
   - **Nickname:** Edit a name for the device as you want.
   - **Server Address:** Input the IP Server address.
   - **Device ID:** Input the device ID registered on the IP server.
   - **User Name:** Input the device user name. By default, the user name is `admin`.
   - **Password:** Input the device password. By default, the password is `12345`.
4. Optionally, you can check the checkbox **Export to Group** to create a group by the device name. All the channels of the device will be imported to the corresponding group by default.
5. Click **Add** to add the device.
2.2.5 Adding Devices by HiDDNS

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select HiDDNS as the adding mode.
3. Input the required information.
   - **Nickname:** Edit a name for the device as you want.
   - **Server Address:** www.hik-online.com.
   - **Device Domain Name:** Input the device domain name registered on HiDDNS server.
   - **User Name:** Input the device user name. By default, the user name is admin.
   - **Password:** Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox **Export to Group** to create a group by the device name. All the channels of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

![Add Device Dialog Box](image)

**Note:** iVMS-4200 also provides a method to add the offline devices. Check the checkbox **Add Offline Device**, input the required information and the device channel count, and then click Add. When the offline device comes online, the software will connect it automatically.

The devices will be displayed on the device list for management after added successfully. You can check the resource usage, HDD status, recording status, and other information of the added devices on the list.

Click **Refresh All** to refresh the information of all added devices. You can also input the device name in the filter field for search.

Select device from the list, click **Modify/Delete**, and then you can modify/delete the information of the selected device.

Select device from the list, click **Remote Config**, and then you can do some remote configurations of the selected device if needed.
2.3 Group Management

**Purpose:**
The devices added can be organized into groups for a convenient management. You can get the live view, play back the record files, and do some other operations of the device through the group.

**Before you start:**
Devices need to be added to the client software for group management.

Perform the following steps to enter the Group Management interface:
1. Open the Device Management page.
2. Click the **Group** tab to enter the Group Management interface.

**Steps:**
1. Click **Add Group** to open the Add Group dialog box.
2. Input a group name as you want.
3. Click **OK** to add the new group to the group list.
   You can also check the checkbox **Create Group by Device Name** to create the new group by the name of the selected device.

**Importing Encoding Device to Group**

**Steps:**
1. Click **Import** on Group Management interface, and then click the **Encoding Channel** tab to open
the Import Encoding Channel page.
2. Select the thumbnails/names of the encoding channels in the thumbnail/list view.
3. Select a group from the group list.
4. Click **Import** to import the selected encoding channels to the group.
   
   You can also click **Import All** to import all the encoding channels to a selected group.

**Notes:**
- You can also click the icon on the Import Encoding Channel page to add a new group.
- Up to 64 cameras can be added to one group.

The following buttons are available on the Import Encoding Channel page:
- **List View**: View the encoding channel in list view.
- **Thumbnail View**: View the encoding channel in thumbnail view.
- **Refresh**: Refresh the latest information of added encoding channels.
- **Import**: Create a group by device name and import the device to group.
- **Collapse/Expand**: Collapse/Expand the thumbnails of encoding channels.

### Modifying the Group/Channel

**Steps:**
1. Select the group/channel from the group list on the Import Encoding Channel page.
2. Click , or double-click the group/channel name to open Modify Group/Camera dialog box.
3. Edit the group/channel information, including the group/camera name, the camera type, etc.
4. Click **OK** to save the new settings.
   
   You can also double-click the group/channel name on the Group Management interface to open the Modify Group/Camera dialog box.
Removing Channels from the Group

**Steps:**
1. Select the channel from the group list on the Import Encoding Channel page.
2. Click \( \checkmark \) to remove the channel from the group.
   - You can also select the channel on the Group Management interface, and then click **Delete** to remove the channel from the group.
   - Select the group from the group list on the Import Encoding Channel page, and Click \( \checkmark \). You can remove all the channels from the group.

Deleting the Group

**Steps:**
1. Select the group on the Group Management interface.
2. Click **Delete Group** or click the icon \( \checkmark \) and the selected group will be deleted.

2.4 Basic Operations in Live View

**Purpose:**
For the surveillance task, you can view the live video of the added network cameras and video encoders on the Main View page. And some basic operations are supported, including picture capturing, manual recording, PTZ control, etc.

**Before you start:**
A camera group is required to be defined for live view.

Click the \( \) icon on the control panel,
or click **View**->**Main View** to open the Main View page.
Main View Page
1 View List
2 Camera List
3 PTZ Control Panel
4 Display Window of Live View
5 Live View Toolbar

Camera Status:
The camera is online and works properly.
The camera is in live view.
The camera is in recording status.
The camera is offline.

Live View Toolbar:

On the Main View page, the following toolbar buttons are available:
- Set View: Set the screen layout mode and save the new settings for the current view; save the current view as another new view.
- Stop Live View: Stop the live view of all cameras.
- Previous: Go for live view of the previous page.
- Next: Go for live view of the next page.
- Resume/Pause: Click to resume/pause the auto-switch in live view.
- Auto-switch: Show/Hide the config menu of auto-switch. Click again to hide.
- Mute/Audio On: Turn off/on the audio in live view
- Full Screen: Display the live view in full screen mode. Press ESC to exit.

Right-click on the display window in live view to open the Live View Management Menu:
The following buttons are available on the right-click Live View Management Menu:

- **Stop Live View**: Stop the live view in the display window.
- **Capture**: Capture the picture in the live view process.
- **Print Captured Picture**: Capture the current picture and then print the picture.
- **Send Email**: Capture the current picture and then send an Email notification to one or more receivers. The captured picture can be attached.
- **Start/Stop Recording**: Start/Stop the manual recording. The record file is stored in the PC.
- **Open Window PTZ Control**: Enable PTZ control function on the display window. Click again to disable the function.
- **Open Digital Zoom**: Enable the digital zoom function. Click again to disable the function.
- **Switch to Instant Playback**: Switch to instant playback mode.
- **Start/Stop Two-way Audio**: Click to start/stop the two-way audio of the camera in live view.
- **Enable/Disable Audio**: Click to enable/disable the audio in live view.
- **Camera Status**: Display the status of the camera in live view, including the recording status, signal status, connection number, etc.
- **Remote Configuration**: Open the remote configuration page of the camera in live view.
- **Synchronization**: Sync the camera in live view with the PC running the client software.
- **Full Screen**: Display the live view in full screen mode. Click the icon again to exit.

### 2.4.1 Starting and Stopping the Live View

#### Starting Live View for One Camera

**Steps:**

1. Open the Main View page.
2. Optionally, click the icon in live view toolbar, then click the screen layout button and select the screen layout mode for live view.
3. Click-and-drag the camera to the display window,
or double-click the camera name after selecting the display window to start the live view.

**Note:** You can click-and-drag the video of the camera in live view to another display window if needed.

### Starting Live View for Camera Group

**Steps:**
1. Open the Main View page.
2. Click-and-drag the group to the display window, or double-click the group name to start the live view.

**Note:** The display window number is self-adaptive to the camera number of the group.

### Starting Live View in Default View Mode

**Purpose:**
The video of the added cameras can be displayed in different view modes. 4 frequently-used default view modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.

**Steps:**
1. Open the Main View page.
2. Click the icon to expand the default view list.
3. Click to select the default view mode, and the video of the added cameras will be displayed in a sequence in the selected view.

**Note:** Right-click the current default view name on the list and click **Save View As**, and you can save the default view as a custom view.

### Starting Live View in Custom View Mode

**Purpose:**
The view mode can also be customized for the video live view.

**Steps:**
1. Open the Main View page.
2. Click the icon to expand the custom view list.
3. Click **New View** in the custom view list to create a new view.
4. Input the view name and click **Add**. The new view is of 4-Screen mode by default.
5. Optionally, Click the icon in live view toolbar, then click the screen layout button and select the screen layout mode for the new view.
6. Click-and-drag the camera/group to the display window, or double-click the camera/group name in custom view mode to start the live view.
7. Click the icon to save the new view.

Right-click the custom view name on the list, and a menu pops up as follows:

![Menu](image)

The following buttons are available on the right-click menu:
Stopping the Live View

Steps:
1. Select the display window.
2. Click the icon that appears in the upper-right corner when the mouse pointer is over the display window,
   or click Stop Live View on the right-click menu to stop the live view of the display window.
   You can also click the button in live view toolbar to stop all the live view.

2.4.2 Auto-switch in Live View

Camera Auto-switch

Purpose:
The video stream of the cameras from the same group will switch automatically in a selected display window in camera auto-switch.

Steps:
1. Open the Main View page.
2. Select a display window for camera auto-switch.
3. Click the icon in the toolbar and select the switching interval.
4. Select a group and click the icon on the group node.
5. You can click the icon to pause/resume the camera auto-switch.

Single View Auto-switch

Purpose:
The video of all the cameras on the camera list will switch automatically in a selected default view in single view auto-switch.

Steps:
1. Open the Main View page.
2. Click the icon in the toolbar and select the switching interval.
3. Select a default view and click the icon on the selected view node.
4. You can click the icon to pause/resume the single view auto-switch.

Multi-view Auto-switch

Purpose:
The custom views will switch automatically in multi-view auto-switch. The custom views need to be added before proceeding.

Steps:
1. Open the Main View page.
2. Click the icon in the toolbar and select the switching interval.
3. Click the icon on the custom view node.
4. You can click the icon to pause/resume the multi-view auto-switch.

2.4.3 PTZ Control in Live View

The software provides PTZ control for cameras with pan/tilt/zoom functionality. You can set the preset, patrol and pattern for the cameras on the PTZ Control panel. And you can also open window PTZ control for the operations of PTZ cameras.

Click the icon to expand the PTZ Control panel.

The following buttons are available on the PTZ Control panel:
- Zoom
- Focus
- Iris
- Auxiliary Focus
- 3D Positioning
- Light
- Wiper
- Lens Initialization

Configuring the Preset

A preset is a predefined image position which contains information of pan, tilt, focus and other parameters.

Perform the following steps to add a preset:
1. Click the Preset button to enter the PTZ preset configuration panel.
2. Click the direction buttons on the PTZ control panel to steer the camera to the desired view.
3. Select a PTZ preset number from the preset list and click.
4. Input the name of the preset in the pop-up dialog box.
5. Click OK to save the settings.
To call a configured preset, double-click the preset, or select the preset and click the icon.
To modify a configured preset, select the preset from the list and click the icon.
To delete a configured preset, select the preset from the list and click the icon.

Configuring the Pattern

A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions. Perform the following steps to add a pattern:

1. Click the Pattern button to enter the PTZ pattern configuration panel.
2. Click to start recording of this pattern path.
3. Use the direction buttons to control the PTZ movement.
4. Click to stop and save the pattern recording.
5. Click the icon to call the pattern. To stop calling the pattern, click.

Note: Only one pattern can be configured, and the newly-defined pattern will overwrite the previous one.

Configuring the Patrol

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed between two presets and the dwell time at the preset separately programmable.
**Before you start:**

Two or more presets for one PTZ camera need to be added. Perform the following steps to add and call a patrol:

1. Click the **Patrol** button to enter the PTZ patrol configuration panel.
2. Select a track number from the drop-down list.
3. Click to add a preset, and set the dwell time and patrol speed for the preset.
4. Repeat the above operation to add other presets to the patrol.
5. Optionally, you can click or to edit or delete a preset in the patrol path.
6. Click the icon to call the patrol. To stop calling the patrol, click .

**Notes:**

- Up to 16 patrols can be configured.
- The preset dwell time can be set to 1~255 sec, and the patrol speed can be set to level 1~40.

---

**2.4.4 Manual Recording and Capture**

**Toolbar in Each Live View Display Window:**

In each live view display window, the following toolbar buttons are available:

- ![Capture](image)
  - Capture the picture in the live view process.
- ![Start/Stop Recording](image)
  - Start/Stop manual recording. The record file is stored in the PC.
- ![Switch to Instant Playback](image)
  - Switch to the instant playback mode.

**Manual Recording in Live View**

**Purpose:**

Manual Recording function allows you to record the live video on the Main View page manually and the record files are stored in the local PC.

**Steps:**

1. Move the mouse pointer to the display window in live view to show the toolbar.
2. Click in the toolbar of the display window or on the right-click Live View Management Menu.
to start the manual recording. The icon 🗂️ turns to 🗂️️.

3. Click the icon 🗂️️ to stop the manual recording.

A prompt box with the saving path of the video files you just recorded will pop up if all the operations succeed.

**Notes:**
- During the manual recording, an indicator 🗂️️ appears in the upper-right corner of the display window.
- The saving path of video files can be set on the System Configuration interface. For details, see Section 7.2.2 File Saving Path Settings.

### Viewing Local Record Files

**Steps:**

1. Click File->Open Video File to open the Record Files page.
2. Select the camera to be searched from the Camera Group list.
3. Click the icon 🗂️ to specify the start time and end time for the search.
4. Click Search. The video files recorded between the start time and end time will be displayed.
   - Select the video file, and click Delete. You can delete the video file.
   - Select the video file, and click Email Linkage. You can send an Email notification with the selected video file attached.
   - Select the video file, and click Save as. You can save a new copy of the video file.

**Note:** To send an Email notification, the Email settings need to be configured before proceeding. For details, see Section 7.2.5 Email Settings.

Double-click the video file and the video file can be played back locally.
The following buttons are available on the local playback page:

- **CIF/4CIF**: Display the video in cif/4cif resolution.
- **Full Screen**: Display the local playback page in full screen mode.
- **Close**: Close the local playback page of the record files.
- **Pause/Play**: Pause/Start the playback of the record files.
- **Stop**: Stop the playback of the record files.
- **Speed**: Set the playback speed.
- **Single Frame**: Play back the record files frame by frame.
- **Digital Zoom**: Enable the digital zoom function. Click again to disable.
- **Enable/Disable Audio**: Click to enable/disable the audio in the local playback.
- **Capture**: Capture the picture in the playback process.

**Capturing Picture in Live View**

*Steps:*
1. Move the mouse pointer to the display window in live view to show the toolbar.
2. Click the icon in the toolbar of the display window or on the right-click Live View Management Menu.
   A small window of the captured picture will be displayed to notify whether the capturing operation is done or not.

*Note:* The saving path of the captured pictures can be set on the System Configuration interface. For details, see Section 7.2.2 File Saving Path Settings.

**Viewing Captured Pictures**

The pictures captured in live view are stored in the PC running the software. You can view the captured pictures if needed.

*Steps:*
1. Click File->Open Captured Picture to open the Captured Picture page.
2. Select the camera to be searched from the Camera Group list.
3. Click the icon 🖼️ to specify the start time and end time for the search.
4. Click Search. The pictures captured between the start time and end time will be displayed.
5. Double-click the captured picture to enlarge it for a better view.
   - Select the captured picture, and click Print. You can print the selected picture.
   - Select the captured picture, and click Delete. You can delete the selected picture.
   - Select the captured picture, and click Email Linkage. You can send an Email notification with the selected picture attached.
   - Select the captured picture, and click Save as. You can save a new copy of the selected picture.

2.4.5 Instant Playback

**Purpose:**
The record files can be played back instantly on the Main View page. Instant playback shows a passage of the video which was remarkable, or which was unclear on the first sight. Thus, you can get an immediate review if needed.

**Before you start:**
The video files need to be recorded on the storage devices, such as the SD/SDHC cards and HDDs on the DVRs, NVRs, Network Cameras, etc., or on the storage servers.

**Steps:**
1. Start the live view and move the mouse pointer to the display window to show the toolbar.
2. Click the icon 📄 in the toolbar and a list of time periods pops up.
   - 30s, 1 min, 3 min, 5 min, 8 min, and 10 min are selectable.
3. Select a time period to start the instant playback.
   - Example: If the current time of the live view is 09:30:00, and you select 3 min, then the instant playback will start from 09:27:00.
4. Click the icon 📄 again to stop the instant playback and go back for the live view.

**Notes:**
- During the instant playback, an indicator 🎥 appears in the upper-right corner of the display window.
- The live view process will continue after the instant playback completed.
Right-click on the display window to open the Instant Playback Management Menu:

![Instant Playback Management Menu](image)

The following buttons are available on the right-click Instant Playback Management Menu:

- **Pause/Play**: Pause/Start the instant playback in the display window.
- **Stop**: Stop the instant playback and return to the live view mode.
- **Speed Up/Down**: Increase/Decrease the play speed of the instant playback.
- **Single Frame**: Play back the record file frame by frame.
- **Open Digital Zoom**: Enable the digital zoom function. Click again to disable the function.
- **Capture**: Capture the picture in the instant playback process.
- **Print Captured Picture**: Capture the current picture and then print the picture.
- **Send Email**: Capture the current picture and then send an Email notification to one or more receivers. The captured picture can be attached.
- **Start/Stop Recording**: Start/Stop clipping the record files.
- **Enable/Disable Audio**: Click to turn on/off the audio in instant playback.
- **Switch to Live View**: Switch to live view mode.
- **Full Screen**: Display the instant playback in full screen mode. Click again to exit.
2.4.6 Other Functions in Live View

There are some other functions supported in the live view, including digital zoom, two-way audio, camera status and synchronization.

**Auxiliary Screen Preview**

The live video can be displayed on different auxiliary screens for the convenient preview of multiple monitoring scenes. Up to 3 auxiliary screens are supported.

**Digital Zoom**

Use the left key of mouse to drag a rectangle area in the lower-right/upper-left direction, and then the rectangle area will zoom in/out.

**Two-way Audio**

Two-way audio function enables the voice talk of the camera. You can get not only the live video but also the real-time audio from the camera. This two-way audio can be used for only one camera at one time.

**Camera Status**

The camera status, such as recording status, signal status, connection number, etc., can be detected and displayed for check. The status information refreshes every 10 seconds.

**Synchronization**

The synchronization function provides a way to synchronize the live video clock with the PC which runs the client software.
Chapter 3 Remote Record Schedule Settings and Playback

When the video storage devices are the HDDs, Net HDDs, SD/SDHC cards on the local device, or the remote storage server connected, you can set the record schedule for the cameras for the continuous, alarm triggered or command triggered recording. And the record files can be searched for the remote playback.

3.1 Remote Recording

*Purpose:* The video files can be recorded on the HDDs, Net HDDs, SD/SDHC cards on the local device, or the storage server connected.

Click the icon on the control panel, or click Tool->Record Schedule to open the Record Schedule page.

3.1.1 Recording on Storage Devices on the DVRs, NVRs, or Network Cameras

*Purpose:* Some local devices, including the DVRs, NVRs, and Network Cameras, provide storage devices such as the HDDs, Net HDDs and SD/SDHC cards for record files. You can set a record schedule or capture schedule for the channels of the local devices.

*Note:* The pictures captured through the capture schedule are stored on the local device and can be searched on the remote configuration page of the device.
**Before you start:**
The newly installed storage devices need to be formatted. Go to the remote configuration page of the device, click **Storage->General**, select the HDD or SD/SDHC card, and click **Format** to initialize the selected storage device.

**Steps:**
1. Open the Record Schedule page.
2. Select the camera in the Camera Group list.
3. Check the checkbox **Record Schedule** under Local Recording to enable device local recording.
4. Select the record schedule template from the drop-down list.
   - **All-day Template**: for all-day continuous recording.
   - **Weekday Template**: for working-hours continuous recording from 8:00 AM to 8:00 PM.
   - **Alarm Template**: for motion detection or alarm input triggered recording.
   - **Template 01-08**: fixed templates for specific schedules. You can edit the templates if needed.
   - **Custom**: can be customized as desired.
   If you need to edit or customize the template, see **Configuring Record Schedule Template**.
5. Click **Advanced Settings** to set the recording parameters. For details, see **Table 3.1 Advanced Recording Settings**.
6. Optionally, click **Copy to...** to copy the record schedule settings to other channels.
7. Click **Save** to save the settings.

![Advanced Settings](image)

**Table 3.1 Advanced Recording Settings**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-record</td>
<td>Normally used for the event triggered record, when you want to record before the event happens</td>
</tr>
<tr>
<td>Post-record</td>
<td>After the event finished, the video can also be recorded for a certain time.</td>
</tr>
<tr>
<td>Video Expired Time</td>
<td>The time for keeping the record files in the storage device, once exceeded, the files will be deleted. The files will be saved permanently if the value is set as 0.</td>
</tr>
<tr>
<td>Redundant Record</td>
<td>Save the video files not only in the R/W HDD but also in the redundant HDD.</td>
</tr>
<tr>
<td>Record Audio</td>
<td>Record the video files with audio or not.</td>
</tr>
</tbody>
</table>

**Configuring Record Schedule Template**

Perform the following steps to configure the record schedule template:
If **Template 01-08** is selected from the drop-down list, start from step 1;
If **Custom** is selected from the drop-down list, start from step 2.

1. Click **Edit** to enter the Templates Management interface. Select the template to be set and you can edit the template name.

2. Set the time schedule for the selected template.

   ![Schedule Recording](image1) refer to normal schedule record. The schedule time bar is green/yellow.
   
   ![Event Recording](image2) refers to the schedule record for the alarm input or motion detection event. The schedule time bar is red.
   
   ![Command](image3) refers to the schedule record triggered by command. The schedule time bar is green.

   **Note:** Record triggered by command is only available for the ATM transactions when the ATM DVR is added to iVMS-4200.

   When the cursor turns to ![Schedule Recording](image1), you can edit the schedule time bar.
   
   When the cursor turns to ![Event Recording](image2), you can move the selected time bar you just edited.
   
   When the cursor turns to ![Command](image3), you can lengthen or shorten the selected time bar.

3. **Optionally,** you can select the schedule time bar,
   and then click the icon ![Schedule Recording](image1) to delete the selected time bar,
   or click the icon ![Event Recording](image2) to delete all the time bars,
   or click the icon ![Command](image3) to copy the time bar settings to the other dates.

4. Click **OK** to save the settings.

   You can click **Save as Schedule Template** on the Custom Schedule interface, and then the custom template can be saved as template 01–08.

   **Note:** Up to 8 time periods can be set for each day in the record schedule.
3.1.2 Recording on Storage Server

**Purpose:**
The storage server performs as a NVR installed on the PC. The record files can be stored in the storage server and you can search the files for remote playback.

**Before you start:**
The storage server application software needs to be installed and it is packed in the iVMS-4200 software package. When installing the iVMS-4200, check the checkbox **Storage Server** to enable the installation of storage server.

**Adding the Storage Server**

**Steps:**

1. Click the shortcut icon on the desktop to run the storage server.
   - **Note:** You can also record the video files on the storage server installed on other PC.
2. Open the Device Management page and click the **Server** tab.
3. Click **Add New Device Type**, select **Storage Server** and click **OK**.
4. Click **Storage Server** on the list to enter the Storage Server Adding interface.
You can add the storage server in the following ways:

- By detecting the online devices, see Section 2.2.1 Adding Online Devices.
- By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
- By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
- By IP Server, see Section 2.2.4 Adding Devices by IP Server.

Formatting the HDDs

The HDDs of the storage server need to be formatted for the record file storage.

Steps:
1. Select the added storage server from the list and click Remote Config.
2. Click Storage -> General, to enter the HDD Formatting interface.
3. Select the HDD from the list and click Format. You can check the formatting process from the process bar and the status of the formatted HDD changes from Raw to Normal Status.

Note: Formatting the HDDs is to pre-allocate the disk space for storage and the original data of the formatted HDDs will not be deleted.

Configuring Storage Server Record Schedule

Before you start:

The storage server needs to be added to the client software and the HDDs need to be formatted for the record file storage.

Steps:
1. Open the Record Schedule page.
2. Select the camera from the Camera Group list.
3. Check the checkbox **Storage Server** to enable recording on storage server.
4. Select the storage server from the drop-down list.
5. Select the record schedule template from the drop-down list.
   If you need to edit or customize the template, see **Configuring Record Schedule Template**.
6. Click **Advanced Settings** to set the pre-record time, post-record time and video expired time.
7. Click **Save** to save the settings.

### 3.2 Remote Playback

**Purpose:**
The record files stored on the local device or the storage server can be searched by custom view, camera or triggering event, and then can be played back remotely.

Click the icon on the control panel,

or click **View > Remote Playback** to open the Remote Playback page.

![Remote Playback Page](image)

**Remote Playback Page**

1. View List, Camera List and Event List
2. Calendar
3. Search Options
4. Search Result List
5. Display Window of Playback
6. Playback Toolbar
7. Timeline
3.2.1 Normal Playback

Purpose:
The record files can be searched by custom view, camera or triggering event for the Normal Playback.

Searching Record Files for Normal Playback

Steps:
1. Open the Remote Playback page.
2. Click to expand the View List or Camera List on the left-side.
3. Select the view or camera to be searched from the list.
4. Select the day to be searched on the calendar.
   You can also click to show more search options, and then click the icon to specify the start time and end time for the search.
5. Click Search. The record files of the selected view or camera will be displayed on the Search Result list. You can filter the results through the Filter text field.

Notes:
- You can also search the record files by the card number (only applicable to ATM DVR) or by the file type.
- If there are record files for that camera in that day, in the calendar, the icon for that day is displayed as. Otherwise it is displayed as.
- Up to 16 cameras can be searched simultaneously.

Normal Playback

After searching the record files for the normal playback, you can play back the record files in the following two ways:
- Playback by File List
  Select the record file from the search result list, and then click the icon in the toolbar, or double-click the record file to play the video on the display window of playback.
- Playback by Timeline
  The timeline indicates the time duration for the record file, and the record files of different types are color coded. Click on the timeline to play back the video of the specific time.
  You can click or to scale up or scale down the timeline bar.
You can click [ or ] to go to the previous or the next time period. You can use the mouse wheel to zoom in or zoom out on the timeline.

Normal Playback Toolbar:

On the Normal Playback page, the following toolbar buttons are available:

- **Async/Sync Playback**: Click to play back the record files synchronously/asynchronously.
- **Stop Playback**: Stop the playback of all cameras.
- **Pause/Start Playback**: Pause/Start the playback of the record files.
- **Single Frame**: Play back the record files frame by frame.
- **Volume**: Click to turn on/off the audio and adjust the audio volume.
- **Full Screen**: Display the video playback in full screen mode. Press ESC to exit.

Note: You can move the slider on the Playback Speed Bar to set the playback speed.

### 3.2.2 Event Playback

**Purpose:**
The recordings triggered by motion detection or alarm input can be searched for Event Playback and this function requires the support of the connected device.

**Searching Record Files for Event Playback**

**Steps:**
1. Open the Remote Playback page.
2. Click [ to expand the Event List on the left-side.
3. Click Motion Detection or Alarm Input, and select the cameras or alarm input sensors.
4. Select the day to be searched on the calendar. You can also click [ to show more search options, and then click the icon [ to specify the start time and end time for the search.
5. Click Search. The recordings from the selected cameras and sensors triggered by motion
detection or alarm input will be displayed on the Search Result list.

**Event Playback**

After searching the recordings triggered by the event, you can play back the record files in the following two ways:

- **Playback by File List**
  Select the record file from the search result list, and then click the icon in the toolbar, or double-click the record file to play the video on the display window of playback.

- **Playback by Timeline**
  The timeline indicates the time duration for the record file. Click on the timeline to play back the video of the specific time.
  
  You can click or to scale up or scale down the timeline bar.
  
  You can click or to go to the previous or the next time period.
  
  You can use the mouse wheel to zoom in or zoom out on the timeline.

**Event Playback Toolbar:**

On the Remote Playback page, the following toolbar buttons are available:

- **Stop Playback** Stop the playback of all channels.
- **Pause/Start Playback** Pause/Start the playback of record files.
- **Single Frame** Play back the record files frame by frame.
- **Previous Event** Go to the playback of the previous event.
- **Next Event** Go to the playback of the next event.
- **Volume** Click to turn on/off the audio and adjust the audio volume.
- **Full Screen** Display the video playback in full screen mode. Press **ESC** to exit.

You can move the slider on the Playback Speed Bar to set the playback speed.

### 3.2.3 Synchronous Playback

**Purpose:**

In synchronous playback, the record files can be played back in synchronization.

**Note:** Record files from up to 16 cameras can be played back simultaneously.

**Synchronous Playback for Some Searched Cameras**

**Steps:**

1. Start the normal playback of the searched cameras.
2. Click in the toolbar, and then the record files in normal playback will be played in sync. The icon turns to .
3. To disable the synchronous playback, click the icon .

**Synchronous Playback for All Searched Cameras**

**Steps:**

1. Search the record files for the normal playback.
2. Click in the toolbar to enable the synchronous playback. The icon turns to.
3. Select the record file from the list and click  
or click on the timeline to start the synchronous playback for all searched cameras.
4. To disable the synchronous playback, click the icon .
Chapter 4 Event Management

Purpose:
In iVMS-4200 client software, rules can be set up for triggers and linkage actions. You can assign linkage actions to the trigger by setting up a rule. For example, when motion is detected, an audible warning appears or other linkage actions happen.

Click the icon on the control panel, or click Tool->Event Management to open the Event Management page.

You can set different linkage actions for the following triggers:
- Motion Detection
- Tampering Alarm
- PIR Alarm
- Video Loss
- Alarm Input
- Device Exception

4.1 Configuring Motion Detection Alarm

Purpose:
A motion detection alarm is triggered when the client software detects motion within its defined area. The linkage actions, including alarm output, channel record and client action can be set.

Steps:
1. Open the Event Management page and click Camera Event tab.
2. Select the camera to be configured and select Motion Detection as the event type.
3. Check the checkbox Enable to enable the function of motion detection.
4. Select the arming schedule template from the drop-down list.
   - All-day Template: for all-day continuous arming.
   - Weekday Template: for working-hours continuous arming from 8:00 AM to 8:00 PM.
Template 01-09: fixed templates for special schedules. You can edit the templates if needed.

Custom: can be customized as desired.

If you need to edit or customize the template, see Configuring Arming Schedule Template.

5. Click-and-drag the mouse to draw a defined area for the arming region.

You can click the icon ☑️ to set the whole video area as detection area, or click the icon ❌ to clear all the detection area.

6. Drag the slider on the sensitivity bar to adjust the motion detection sensitivity. The larger the value is, the more sensitive the detection is.

7. Check the checkboxes to activate the linkage actions. For details, see Table 4.1 Linkage Actions for Motion Detection Alarm.

8. Optionally, click Copy to... to copy the event parameters to other channels.

9. Click Save to save the settings.

![Diagram showing arming and detection regions]

**Table 4.1 Linkage Actions for Motion Detection Alarm**

<table>
<thead>
<tr>
<th>Linkage Actions</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Output</td>
<td>Enable the alarm output function. Select the alarm output port and the external device connected to the port can be controlled.</td>
</tr>
<tr>
<td>Channel Record</td>
<td>Start the recording of the selected cameras when alarm is triggered.</td>
</tr>
<tr>
<td>Audible Warning</td>
<td>The client software gives an audible warning when alarm is triggered.</td>
</tr>
<tr>
<td>Email Linkage</td>
<td>Send an Email notification of the alarm information to one or more receivers.</td>
</tr>
<tr>
<td>Alarm on E-map</td>
<td>Display the alarm information on the E-map.</td>
</tr>
<tr>
<td>Alarm Triggered</td>
<td>The Image with alarm information pops up when alarm is triggered.</td>
</tr>
<tr>
<td>Video Wall Display</td>
<td>Display the video on the Video Wall when alarm is triggered.</td>
</tr>
</tbody>
</table>

**Configuring Arming Schedule Template**

Perform the following steps to configure the arming schedule template:

If Template 01-09 is selected in the drop-down list, start from step 1;
If **Custom** is selected in the drop-down list, start from step 2.

**Steps:**

1. Click **Edit** to enter the Templates Management interface. Select the template to be set and you can edit the template name.
2. Set the time schedule for the selected template.
   - When the cursor turns to , you can edit the schedule time bar.
   - When the cursor turns to , you can move the selected time bar you just edited.
   - When the cursor turns to , you can lengthen or shorten the selected time bar.
3. Optionally, you can select the schedule time bar, and then click the icon to delete the selected time bar, or click the icon to delete all the time bars, or click the icon to copy the time bar settings to the other dates.
4. Click **OK** to save the settings.

   You can click **Save as Schedule Template** on the Custom Schedule interface, and then the custom template can be saved as template 01–09.

**Note:** Up to 4 time periods can be set for each day in the arming schedule template.
4.2 Configuring Tampering Alarm

Purpose:
A tampering alarm is triggered when the camera is covered and the monitoring area cannot be viewed. The linkage actions, including alarm output and client action can be set.

Steps:
1. Open the Event Management page and click the Camera Event tab.
2. Select the camera to be configured and select Tampering Alarm as the event type.
3. Check the checkbox Enable to enable the function of tampering alarm.
4. Select the arming schedule template from the drop-down list. If you need to edit or customize the template, see Configuring Arming Schedule Template.
5. Select the triggered camera. The image or video from the triggered camera will pop up or be displayed on the Video Wall when tampering alarm occurs.
6. Click-and-drag the mouse to draw a defined area for the arming region.
7. Drag the slider on the sensitivity bar to adjust the tampering alarm sensitivity.
8. Check the checkboxes to activate the linkage actions. For details, see Table 4.2 Linkage Actions for Tampering Alarm.
9. Optionally, click Copy to... to copy the event parameters to other cameras.
10. Click Save to save the settings.

<table>
<thead>
<tr>
<th>Linkage Actions</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Output</td>
<td>Enable the alarm output function. Select the alarm output port and the external device connected to the port can be controlled.</td>
</tr>
<tr>
<td>Audible Warning</td>
<td>The client software gives an audible warning when alarm is triggered.</td>
</tr>
<tr>
<td>Email Linkage</td>
<td>Send an Email notification of the alarm information to one or more receivers.</td>
</tr>
<tr>
<td>Alarm on E-map</td>
<td>Display the alarm information on the E-map.</td>
</tr>
<tr>
<td>Alarm Triggered Pop-up Image</td>
<td>The Image of the triggered camera pops up when alarm is triggered.</td>
</tr>
</tbody>
</table>
### Alarm Triggered Video Wall Display

Display the video of the triggered camera on the Video Wall when alarm is triggered.

---

### 4.3 Configuring PIR Alarm

**Purpose:**

A PIR (Passive Infrared) alarm is triggered when an intruder moves within the detector's field of view. The heat energy dissipated by a person, or any other warm blooded creature such as dogs, cats, etc., can be detected.

**Note:** The PIR Alarm function requires the support of connected device.

**Steps:**

1. Open the Event Management page and click the **Camera Event** tab.
2. Select the camera to be configured and select **PIR Alarm** as the event type.
3. Check the checkbox **Enable** to enable the function of PIR alarm.
4. Input a descriptive name of the alarm.
5. Check the checkboxes to activate the linkage actions. For details, see Table 4.3 *Linkage Actions for PIR Alarm*.
6. Optionally, click **Copy to...** to copy the event parameters to other channels.
7. Click **Save** to save the settings.

<table>
<thead>
<tr>
<th>Linkage Actions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Output</td>
<td>Enable the alarm output function. Select the alarm output port and the external device connected to the port can be controlled.</td>
</tr>
<tr>
<td>Channel Record</td>
<td>Start the recording of the selected cameras when alarm is triggered.</td>
</tr>
<tr>
<td>Audible Warning</td>
<td>The client software gives an audible warning when alarm is triggered.</td>
</tr>
<tr>
<td>Email Linkage</td>
<td>Send an Email notification of the alarm information to one or more receivers.</td>
</tr>
<tr>
<td>Alarm on E-map</td>
<td>Display the alarm information on the E-map.</td>
</tr>
</tbody>
</table>
4.4 Configuring Video Loss Alarm

*Purpose:* When the client software cannot receive video signal from the front-end devices, the video loss alarm will be triggered. The linkage actions, including alarm output and client action can be set.

*Steps:*
1. Open the Event Management page and click **Camera Event** tab.
2. Select the camera to be configured and select **Video Loss** as the event type.
3. Check the checkbox **Enable** to enable the function of video loss alarm.
4. Select the arming schedule template from the drop-down list.
   If you need to edit or customize the template, see *Configuring Arming Schedule Template*.
5. Select the triggered camera. The image or video from the triggered camera will pop up or be displayed on the Video Wall when video loss alarm occurs.
6. Check the checkboxes to activate the linkage actions. For details, see *Table 4.4 Linkage Actions for Video Loss Alarm*.
7. Optionally, click **Copy to**... to copy the event parameters to other cameras.
8. Click **Save** to save the new settings.

*Table 4.4 Linkage Actions for Video Loss Alarm*

<table>
<thead>
<tr>
<th>Linkage Actions</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Output</td>
<td>Enable the alarm output function. Select the alarm output port and the external device connected to the port can be controlled.</td>
</tr>
<tr>
<td>Audible Warning</td>
<td>The client software gives an audible warning when alarm is triggered.</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Email Linkage</td>
<td>Send an Email notification of the alarm information to one or more receivers.</td>
</tr>
<tr>
<td>Alarm on E-map</td>
<td>Display the alarm information on the E-map.</td>
</tr>
<tr>
<td>Alarm Triggered Pop-up Image</td>
<td>The Image of the triggered camera pops up when alarm is triggered.</td>
</tr>
<tr>
<td>Alarm Triggered Video Wall Display</td>
<td>Display the video of the triggered camera on the Video Wall when alarm is triggered.</td>
</tr>
</tbody>
</table>

### 4.5 Configuring Alarm Input Linkage

**Purpose:**
When a device's alarm input port receives a signal from an external alarm device, such as smoke detector, doorbell, etc., the alarm input linkage actions are triggered for notification.

**Before you start:**
Add the alarm inputs to the client, click **Import** on the Group Management interface, click the **Alarm Input** tab and import alarm inputs into groups for management.

**Steps:**
1. Open the Event Management page and click the **Alarm Input** tab.
2. Select the alarm input channel to be configured.
3. Check the checkbox **Enable**.
4. Input a descriptive name of the alarm.
5. Set the alarm status according to the alarm input device.
6. Select the arming schedule template from the drop-down list.
   - If you need to edit or customize the template, see *Configuring Arming Schedule Template*.
7. Check the checkboxes to activate the linkage actions. For details, see *Table 4.5 Linkage Actions for Alarm Input*.
8. Optionally, click **Copy to...** to copy the event parameters to other alarm inputs.
9. Click **Save** to save the settings.
### Table 4.5 Linkage Actions for Alarm Input

<table>
<thead>
<tr>
<th>Linkage Actions</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Output</td>
<td>Enable the alarm output function. Select the alarm output port and the</td>
</tr>
<tr>
<td></td>
<td>external device connected to the port can be controlled.</td>
</tr>
<tr>
<td>Channel Record</td>
<td>Start the recording of the selected cameras when alarm is triggered.</td>
</tr>
<tr>
<td>Audible Warning</td>
<td>The client software gives an audible warning when alarm is triggered.</td>
</tr>
<tr>
<td>Email Linkage</td>
<td>Send an Email notification of the alarm information to one or more receivers.</td>
</tr>
<tr>
<td>Alarm on E-map</td>
<td>Display the alarm information on the E-map.</td>
</tr>
<tr>
<td>Alarm Triggered Video</td>
<td>The Image with alarm information pops up when alarm is triggered.</td>
</tr>
<tr>
<td>Wall Display</td>
<td>Display the video on the Video Wall when alarm is triggered.</td>
</tr>
</tbody>
</table>

### 4.6 Configuring Device Exception Linkage

**Steps:**
1. Open the Event Management page and click the **Device Exception** tab.
2. Select the device to be configured.
3. Select the device exception type, including HDD full, HDD exception, illegal login, etc.
4. Check the checkbox **Enable**.
5. Check the checkboxes to activate the linkage actions. For details, see Table 4.6 Linkage Actions for Device Exception.
6. Optionally, click **Copy to...** to copy the event parameters to other devices.
7. Click **Save** to save the settings.
### Table 4.6 Linkage Actions for Device Exception

<table>
<thead>
<tr>
<th>Linkage Actions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Output</td>
<td>Enable the alarm output function. Select the alarm output port and the external device connected to the port can be controlled.</td>
</tr>
<tr>
<td>Audible Warning</td>
<td>The client software gives an audible warning when alarm is triggered.</td>
</tr>
<tr>
<td>Email Linkage</td>
<td>Send an Email notification of the alarm information to one or more receivers.</td>
</tr>
</tbody>
</table>

#### 4.7 Viewing Alarm and Event Information

The information of recent alarms and events can be displayed. Click the icon in Alarms and Events Toolbar to show the Alarms and Events panel.

On the Alarms and Events panel, the following toolbar buttons are available:

- **Clear Info**: Clear the information of alarms and events displayed on the list.
- **Enable/Disable Alarm**: Click to enable/disable image pop-up when alarms occur.
- **Triggered Pop-up Image**: Click to enable/disable the audio warning for the alarm.
- **Enable/Disable Audio**: Click to hide automatically/lock the Alarms and Events panel.
Maximize

Maximize the Alarms and Events panel in a new tab page.

Show/Hide

Click to show/hide the Alarms and Events panel.

**Viewing Alarms Information**

Different alarm types can be displayed on the panel: Motion Detection, Video Exception, Alarm Input and Device Exception. You can check the checkbox to enable the displaying of that type alarm.

**Before you start:**

To display the alarms, the event parameters need to be configured.

**Steps:**

1. Click the **Alarm** tab.
2. Check the checkboxes of different alarm types.
3. When an alarm occurs, the icon `�` twitches to call attention. The alarm information, including the time, source, details and content will be displayed.
   - Click `�` to get a live view of the alarm triggered camera.
   - Click `�` to send an Email notification of the alarm to one or more receivers.
   - Click `�` to display the video of alarm triggered camera on the Video Wall.
   - Click under the Note column to input a prompt message for the alarm.
4. To clear the alarm information, click the icon `�`, or right-click on an alarm log and then click `Clear`.

**Viewing Events Information**

**Purpose:**

The abnormal events of the client software, such as the live view failure, device disconnection, can also be displayed.

**Steps:**

1. Click the **Event** tab.

   The event information, including the time and detailed description will be displayed.
2. To clear the event information, click the icon `�` or right-click on the event log and then click `Clear`. 
Chapter 5 E-map Management

Purpose:
The E-map function gives a visual overview of the locations and distributions of the installed cameras and alarm input devices. You can get the live view of the cameras on the map, and you will get a notification message from the map when alarm is triggered.

Click the icon on the control panel, or click View > E-map to open the E-map page.

E-map Page
1 Group List
2 Map Display Area
3 E-map Toolbar

5.1 Adding an E-map

Purpose:
An E-map needs to be added as the parent map for the hot spots and hot regions.

Steps:
1. Open the E-map page.
2. Select a group for which you want to add a map.
3. Click the icon in the Map Display Area to open the map adding dialog box.
4. Input a descriptive name of the added map as desired.
5. Click the icon and select a map file from the local path.
6. Click OK to save the settings.

Notes:
• The picture format of the map can only be *.png, *.jpg or *.bmp.
• Only one map can be added to a group.

The map added is displayed in the Map Display Area. Use the mouse wheel to zoom in or zoom out on the map. You can click-and-drag the yellow window in the lower-right corner or use the direction buttons and zoom bar to adjust the map area for view.

Click the button **Edit Map** or **Map Preview** in the E-map toolbar to enter the map editing mode or map preview mode.

**E-map Toolbar in Map Editing Mode:**

**E-map Toolbar in Map Preview Mode:**

On the E-map page, the following toolbar buttons are available:

- **Modify Map**
  Modify the map information, including the map name and file path.

- **Delete Map**
  Delete the current map.

- **Add Camera**
  Add a camera as the hot spot on the map.

- **Add Alarm Input**
  Add an alarm input sensor as the hot spot on the map.

- **Add Hot Region**
  Add a map as the hot region on the current map.

- **Modify**
  Modify the information of the selected hot spot or hot region.

- **Delete**
  Delete the selected hot spot or hot region.

- **Clear Alarm Info**
  Clear the alarm information displayed on the map.
5.2 The Hot Spot Function

Purpose:
The cameras and alarm inputs can be added on the map and are called the hot spots. The hot spots show the locations of the cameras and alarm inputs, and you can also get the live view and alarm information of the surveillance scenarios through the hot spots.

5.2.1 Adding Hot Spots

Adding Cameras as Hot Spots

Steps:
1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.
2. Click the icon in the toolbar to open the Add Hot Spot dialog box.
3. Check the checkboxes to select the cameras to be added.
4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon.
5. Click OK to save the settings. The camera icons are added on the map as hot spots and the icons of added cameras changes from to in the group list. You can click-and-drag the camera icons to move the hot spots to the desired locations. You can also click-and-drag the camera icons from the group list to the map directly to add the hot spots.

Adding Alarm Inputs as Hot Spots

Steps:
1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.
2. Click the icon in the toolbar to open the Add Hot Spot dialog box.
3. Check the checkboxes to select the alarm inputs to be added.
4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon.
5. Click **OK** to save the settings. The alarm input icons are added on the map as hot spots and the icons of added alarm inputs changes from 📀 to 📀 in the group list. You can click-and-drag the alarm input icons to move the hot spots to the desired locations. You can also click-and-drag the alarm input icons from the alarm input list to the map directly to add the hot spot.

![Image of alarm input icons]

### 5.2.2 Modifying Hot Spots

**Purpose:**
You can modify the information of the added hot spots on the map, including the name, the color, the icon, etc.

**Steps:**
1. Click the **Edit Map** button in the E-map toolbar to enter the map editing mode.
2. Select the hot spot icon on the map and then click 📀 in the toolbar, or double-click the hot spot icon on the map to open the Modify Hot Spot dialog box.
3. You can edit the hot spot name in the text field and select the color, the icon and the linked camera or alarm input.
4. Click **OK** to save the new settings.
   
   To delete the hot spot, select the hot spot icon and click 📀 in the toolbar.
5.2.3 Previewing Hot Spots

Steps:
1. Click the Map Preview button in the E-map toolbar to enter the map preview mode.
2. Double-click the camera hot spots, and you can get the live view of the cameras.
3. If there is any alarm triggered, an icon will appear and twinkle near the hot spot. Click the alarm icon, and then you can check the alarm information, including alarm type and triggering time.

Note: To display the alarm information on the map, the Alarm on E-map functionality needs to be set as the alarm linkage action.

5.3 The Hot Region Function

Purpose:
The hot region function links a map to another map. When you add a map to another map as a hot region, an icon of the link to the added map is shown on the main map. The added map is called child map while the map to which you add the hot region is the parent map.

Note: A map can only be added as the hot region for one time.

5.3.1 Adding Hot Regions

Before you start:
Add another map to the group.

Steps:
1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.
2. Select an added map as the parent map.
3. Click the icon in the toolbar to open the Add Hot Region dialog box.
4. Check the checkbox to select the child map to be linked.
5. Optionally, you can edit the hot region name, and select the hot region color and icon.
6. Click OK to save the settings. The child map icons are added on the parent map as the hot regions. You can click-and-drag the child map icons to move the hot regions to the desired locations.

5.3.2 Modifying Hot Regions

Purpose:
You can modify the information of the hot regions on the parent map, including the name, the color, the icon, etc.

Steps:
1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.
2. Select the hot region icon on the parent map and then click in the toolbar, or double-click the hot region icon to open the Modify Hot Region dialog box.
3. You can edit the hot region name in the text field and select the color, the icon and the linked child map.
4. Click OK to save the new settings.
   To delete the hot region, select the hot region icon and click in the toolbar.
5.3.3 Previewing Hot Regions

Steps:
1. Click the Map Preview button in the E-map toolbar to enter the map preview mode.
2. Click the hot region icon to go to the linked child map.
3. The hot spots can also be added on the hot regions.
4. You can click the icon in the toolbar to go back to the parent map.
   You can also click the icon in the toolbar to clear the alarm information.
Chapter 6 Log Management

Purpose:
The log files of the client software are stored on the local PC and can be searched for checking. 2 types of log files are provided: client logs and server logs. The client logs refer to the log files of the client and are stored on the local PC; the server logs refer to the log files of the connected devices and are stored on the local device.

Click the icon on the control panel to open the Log Search page.

Searching Log Files

Steps:
1. Open the Log Search page.
2. Select the log type. If Server Logs is selected, then click to specify the device for search.
3. Click the icon to specify the start time and end time.
4. Click Search. The log files between the start time and end time will be displayed on the list.
   You can check the operation time, description and other information of the logs.

   Note: Up to 36000 items of logs can be displayed. Please narrow the time range or filter the log type for search if there are too many log files.
Filtering Log Files

**Purpose:**
After searched out successfully, the log files can be filtered by the keyword or condition, and thus you can find the logs as you want.

**Steps:**
1. Click Log Filter or the icon on the Log Search page to expand the Log Filter panel.
2. Select Filter by Keyword, and then input keyword for filtering in the text field; or select Filter by Condition, and then specify log information in the drop-down list.
3. Optionally, you can click More... to filter the log files more accurately.
4. Click Filter to start filtering. You can click Clear Filter to clear the filtering.

![Log Filter Panel](image)

Backing up Log Files

**Purpose:**
The log files, including the client logs and server logs, can be exported for backup.

**Steps:**
1. Select the log file from the list after searching out the log files.
2. Click Backup Log to open the Backup Log dialog box.
3. Click the icon and select a local saving path.
4. Click Backup to export the selected log file for backup.
   
   You can click File→Open Log File to check the information of the backup log files on local PC.

![Backup Log Dialog](image)
Chapter 7 Account Management and System Configuration

7.1 Account Management

*Purpose:* Multiple user accounts can be added to the client software, and you are allowed to assign different permissions for different users if needed.

Click the *Account Management* icon on the control panel, or click **Tool->Account Management** to open the Account Management page.

![Account Management Page](image)

*Note:* The user account you registered to log in the software is set as the super administrator.

Adding the User

*Steps:*
1. Open the Account Management page.
2. Click **Add User** to open the Add User dialog box.
3. Select the user type from the drop-down list. 2 types of user accounts are selectable:
   - **Administrator:** The administrator account has all permissions by default, and can modify the passwords and permissions of all operators and its own account.
   - **Operator:** The operator account has no permission by default and you can assign the permissions manually. An operator can only modify the password of its own account.
4. Input the user name, password and confirm password as desired.
5. Check the checkboxes to assign the permissions for the created user.
6. Optionally, you can click **Default Permission** to restore the default permissions of this user.
7. Click **Save** to save the settings.

*Notes:*
- A user name cannot contain any of the following characters: / : * ? " < > |. And the length of the
password cannot be less than 6 characters.

- Up to 50 user accounts can be added for the client software.

![User Management Interface](image)

### Managing the User

**Purpose:**
After created successfully, the user account is added to the user list on the Account Management page. You can edit or delete the information of the user accounts.

To edit the information of the user, select the user from the list, and click **Edit User**.

To delete the information of the user, select the user from the list, and click **Delete User**.

### 7.2 System Configuration

**Purpose:**
The general parameters, file saving paths, keyboard and joystick shortcuts, alarm sounds and Email settings can be configured.

Click the 🛠️ icon on the control panel, or click **Tool->System Configuration** to open the System Configuration page.
Note: You can click Default Value to restore the defaults of all the system configurations.

7.2.1 General Settings

Purpose:
The frequently-used parameters, including the log expired time, view scale, etc., can be set.

Steps:
1. Open the System Configuration page.
2. Click the General tab to enter the General Settings interface.
3. Configure the general parameters. For details, see Table 7.1 General Parameters.
4. Click Save to save the settings.

Table 7.1 General Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Expired Time</td>
<td>The time for keeping the log files, once exceeded, the files will be deleted.</td>
</tr>
<tr>
<td>View Scale</td>
<td>The view scale of the video in live view or playback. It can be set as Full</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Network Performance</strong></td>
<td>The current network conditions. It can be set as Normal, Better or Best.</td>
</tr>
<tr>
<td><strong>Play Performance</strong></td>
<td>The play performance of the live video. It can be set as Shortest Delay, Real Time, Balanced or Fluency.</td>
</tr>
<tr>
<td><strong>Enable Screen Toolbar Display</strong></td>
<td>Show the toolbar on each display window in live view or playback.</td>
</tr>
<tr>
<td><strong>Enable Auto-login</strong></td>
<td>Log in the client software automatically.</td>
</tr>
<tr>
<td><strong>Prioritize the Playback of Record Files on Storage Server</strong></td>
<td>Play back the video files recorded on the storage server preferentially. Otherwise, play back the video files recorded on the local device.</td>
</tr>
<tr>
<td><strong>Resume Live View Status</strong></td>
<td>Resume the latest live view status after you log in the client again.</td>
</tr>
<tr>
<td><strong>Auto-change Stream Type</strong></td>
<td>Change the stream type automatically in live view according to the size of the display window.</td>
</tr>
<tr>
<td><strong>Auto Time Adjustment</strong></td>
<td>Adjust the time automatically at a specified time point.</td>
</tr>
</tbody>
</table>

### 7.2.2 File Saving Path Settings

**Purpose:**
The video files from manual recording, the captured pictures and the system configuration files are stored on the local PC. The saving paths of these files can be set.

**Steps:**
1. Open the System Configuration page.
2. Click the **File** tab to enter the File Saving Path Settings interface.
3. Click the icon ![icon](image) and select a local path for the files.
4. Click **Save** to save the settings.
7.2.3 Keyboard and Joystick Shortcuts Settings

*Purpose:* DS-1003 keyboard can be connected to the client and be used to control the PTZ cameras. You can set the shortcuts of PC keyboard and USB joystick to get quick and convenient access to the commonly used actions.

*Steps:*
1. Select the COM port from the drop-down list if 1003K keyboard is connected.
2. Select a certain function from the list.
3. Double-click the item field under the PC Keyboard or USB Joystick column.
4. Select the compound keys operation or USB joystick operation from the drop-down list.
5. Click Save to save the settings.

![Keyboard and Joystick Shortcuts Settings](image)

7.2.4 Alarm Sound Settings

*Purpose:* When the alarm, such as motion detection alarm, video exception alarm, etc., is triggered, the client can be set to give an audible warning and the sound of the audible warning can be configured.

*Steps:*
1. Open the System Configuration page.
2. Click the Alarm Sound tab to enter the Alarm Sound Settings interface.
3. Click the icon ![Select File] and select the audio files from the local path for different alarms.
4. Optionally, you can click the icon ![Play] for a testing of the audio file.
5. Click Save to save the settings.

*Note:* The format of the audio file can only be *wav.*
7.2.5 Email Settings

**Purpose:**
An Email notification can be sent when a system alarm occurs. To send the Email to some specified receivers, the settings of the Email need to be configured before proceeding.

**Steps:**
1. Open the System Configuration page.
2. Click the **Email** tab to enter the Email Settings interface.
3. Input the required information.
   - **SMTP Server:** Input the SMTP Server address.
   - **Port:** Input the communication port of Email service. The port is 25 by default.
   - **User Name:** Input the user name of the sender Email address.
   - **Password:** Input the password of the sender Email address.
   - **Sender Address:** Input the Email address of the sender.
   - **Receiver 1—3:** Input the Email address of the receiver. Up to 3 receivers can be set.
4. Optionally, you can check the checkbox **Enable SSL** to increase the security of email sending.
5. Optionally, you can click **Send Test Email** to send an email to the receiver for test.
6. Click **Save** to save the settings.
Chapter 8 Forwarding Video Stream through Stream Media Server

**Purpose:**
There is always a limit of the device remote access number. When there are many users wanting to get remote access to the device to get the live view, you can add the stream media server and get the video data stream from the stream media server, thus to lower the load of the device.

### 8.1 Adding the Stream Media Server

**Before you start:**
The stream media server application software needs to be installed and it is packed in the iVMS-4200 software package. When installing the iVMS-4200, check the checkbox **Stream Media Server** to enable the installation of stream media server.

**Steps:**
1. Click the shortcut icon on the desktop to run the stream media server.
   *Note:* You can also forward the video through the stream media server installed on other PC.
2. Open the Device Management page and click the **Server** tab.
3. Click **Add New Device Type**, select **Stream Media Server** and click **OK**.
4. Click **Stream Media Server** on the list and then click **Add Device**.
   You can add the stream media server in the following two ways:
   - **Adding Stream Media Server Manually**
     Perform the following steps to add the stream media server manually:
     1) Select **IP Address** as the adding mode.
     2) Input the nickname and IP address of the stream media server. The default port value is **554**.
     3) Click **Add** to add the stream media server to the client software.
   - **Adding Stream Media Server by IP Segment**
     Perform the following steps to add the stream media server by IP segment:
     1) Select **IP Segment** as the adding mode.
     2) Input the start IP and end IP. The default port value is **554**.
     3) Click **Add** to add the stream media server to the client software.
Notes: For one client, up to 16 stream media servers can be added.

8.2 Adding Cameras to Stream Media Server to Forward Video Stream

Purpose:
To get the video stream of a camera via stream media server, you need to connect the camera to the stream media server.

Steps:
1. Select the stream media server from the list.
2. Click Configure to enter the Stream Media Server Settings interface.
3. Select the cameras of which the video stream is to be forwarded via the stream media server.
4. Click OK to save the new settings.
5. Go the Main View page and start the live view of the cameras again. You can check the channel number of the video stream forwarded through or sent from the stream media server.

Note: For one stream media server, up to 64 channels of video stream can be forwarded through it and up to 200 channels of video stream can be sent to clients from it.
Chapter 9 Decoding and Displaying Video on Video Wall

The Video Wall module is only available when the decoding device is added to the client. It provides the video decoding functionality, and the decoded video stream can be displayed on the Video Wall for an attention-grabbing performance.

Click the icon on the control panel, or click View > Video Wall to open the Video Wall page.

9.1 Adding the Decoding Device

Purpose:
To display the video on the Video Wall, the decoding device needs to be added to the client.

Steps:
1. Open the Device Management page and click the Server tab.
2. Click Add New Device Type, select Decoding Device and click OK.
3. Click Decoding Device on the list to enter Decoding Device Adding interface.
You can add the decoding device in the following ways:

- By detecting the online devices, see Section 2.2.1 Adding Online Devices.
- By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
- By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
- By IP Server, see Section 2.2.4 Adding Devices by IP Server.

### 9.2 Configuring Video Wall Settings

**Purpose:**
After the decoding device is added successfully, the parameters of Video Wall need to configured for video display.

**Steps:**
1. Open the Video Wall page.
2. Click **Enter Video Wall Config** to enter the Video Wall Configuration interface.
3. There is a 3*3 video wall on the screen by default. You can add a new video wall if needed.

   Perform the following steps to add a new video wall:
   1) Click the icon in the toolbar to open the Add Video Wall dialog box.
   2) Input the nickname, the number of rows and columns of the video wall.
   3) Click **Add**.

To modify the video wall, select the video wall, and click the icon in the toolbar.
To delete the video wall, select the video wall, and click the icon in the toolbar.
4. Click-and-drag the decoding channel on the left-side list to the display window of video wall, to
connect them one-to-one correspondence. You can click [X] in the upper-right corner of the display window to release the connection.

Notes:
- Up to 4 video walls can be added to the client software.
- The total number of the display windows on the video wall should be no more than 100.
- The ranges of the row number and column number are both between 1 and 20.

9.3 Displaying Video on Video Wall

Purpose:
After the settings of the video wall are configured, the video stream from the cameras can be decoded and displayed on the Video Wall.

Steps:
1. Click Back to Operation Page to go back to the Video Wall Operation interface.
2. Select the screen layout mode for the display window and click the icon [ ] to save.
3. Click-and-drag the camera from the left-side list to the display window on the video wall. The video stream from the camera will be decoded and displayed on the Video Wall. Click the icon [ ] and you can get a preview of the video in the lower-right corner of the screen.
Chapter 10 Web Browsing

Purpose:
The iVMS-4200 client software can also be accessed through web browsing. It provides the functionalities of live view, playback, device management, account management, system configuration, etc.

10.1 Login

Steps:
1. Input the IP address of the PC running the iVMS-4200 in the address bar of the web browser, and press the Enter key. A login window will pop up.
2. Input the user name and password of iVMS-4200.
3. Optionally, check the checkbox Remember password to save the password.
4. Click Login.

Note: You can set the language as Chinese or English in the upper-right corner of the login interface.

The homepage of the web browser after you login is shown as below.
10.2 Device Management

**Purpose:**
Before doing any operations via the web browser, devices need to be added to the system for monitoring and management. You can add devices through the web browser.

**Adding the Encoding Device**

**Steps:**
1. Click the **Device Management** tab to open the Device Management page.
2. Click the **Server** tab.
3. Click **Encoding Device** to enter Encoding Device Adding interface.

You can add the encoding device in the following ways:
- **Adding Devices Manually.**
- **Adding Devices by IP Segment.**
- **Adding Devices by IP Server.**
- **Adding Devices by HiDDNS.**

**Adding Devices Manually**

**Steps:**
1. Click the icon to open the device adding dialog box.
2. Select **IP/Domain** as the adding mode from the drop-down list.
3. Input the required information.
   - **Nickname:** Edit a name for the device as you want.
   - **Address:** Input the device’s IP address or domain name.
   - **Port:** Input the device port number. The default value is 8000.
   - **User Name:** Input the device user name. By default, the user name is `admin`.
   - **Password:** Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox **Export to Group** to create a group by the device name. All the channels of the device will be imported to the corresponding group by default.
5. Click **OK** to add the device.
Steps:
1. Click the icon to open the device adding dialog box.
2. Select **IP Segment** as the adding mode from the drop-down list.
3. Input the required information.
   - **Start IP**: Input a start IP address.
   - **End IP**: Input an end IP address in the same network segment with the start IP.
   - **Port**: Input the device port number. The default value is 8000.
   - **User Name**: Input the device user name. By default, the user name is admin.
   - **Password**: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox **Export to Group** to create a group by the device IP. All the channels of the device will be imported to the corresponding group by default.
5. Click **OK**, and the device of which the IP address is between the start IP and end IP will be added to the device list.
Adding Devices by IP Server

Steps:
1. Click the icon to open the device adding dialog box.
2. Select IP Server as the adding mode from the drop-down list.
3. Input the required information.
   - **Nickname**: Edit a name for the device as you want.
   - **Server Address**: Input the IP Server address.
   - **Device ID**: Input the device ID registered on the IP server.
   - **User Name**: Input the device user name. By default, the user name is admin.
   - **Password**: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All the channels of the device will be imported to the corresponding group by default.
5. Click OK to add the device.

Adding Devices by HiDDNS

Steps:
1. Click the icon to open the device adding dialog box.
2. Select HiDDNS as the adding mode from the drop-down list.
3. Input the required information.
   - **Nickname**: Edit a name for the device as you want.
   - **Server Address**: www.hik-online.com.
   - **Device Domain Name**: Input the device domain name registered on the HiDDNS server.
   - **User Name**: Input the device user name. By default, the user name is admin.
   - **Password**: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All the channels of the device will be imported to the corresponding group by default.
5. Click OK to add the device.
Note: Check the checkbox Add Offline Device, input the required information and the device channel count, and then click Add. When the offline device comes online, the software will connect it automatically.

The devices will be displayed on the device list for management after added successfully. You can check the nickname, IP address, serial No., HDD status, recording status and other information of the added devices on the list.

Click Refresh All to refresh the information of all added devices. You can also input the device name in the filter field for search.

Select device from the list, click Modify/Delete, and then you can modify/delete the information of the selected device.

Select device from the list, click Remote Config, and then you can do some remote configurations of the selected device if needed.

Importing Devices to Groups

Purpose:
After the devices added successfully, you can import the devices into groups for a convenient management.

Steps:
1. Open the Device Management page.
2. Click the Group tab to enter the Group Management interface.
3. Click Add Group to open the Add Group dialog box.
4. Input the group name and click OK to create a new group.
5. Click Import to enter the Import Device interface.
6. Select the encoding channels from the device list and then select a group from the group list.
7. Click Import Select to import the selected encoding channels to the group.
   You can also click Import All to import all the encoding channels to a selected group.
Click **Add**, and you can add a new group to the group list.

Click **Modify** after selecting a group/camera, and you can modify the group/camera information.

Click **Delete** after selecting a group/camera, and you can remove all cameras/the selected camera from the group.

To delete a group, select the group from the list on the Group Management interface and click the **Delete Group** button.

### 10.3 Live View

**Purpose:**

On the Live View page, you can view the live video of the added cameras and do some basic operations, including picture capturing, recording, PTZ control, etc.

**Before you start:**

A camera group is required to be defined for live view.

Click the **Live View** tab to open the Live View page.
Starting Live View

Steps:
1. Open the Live View page.
2. Optionally, click the icon in the live view toolbar, and select the screen layout mode.
3. Click-and-drag the camera to the display window, or double-click the camera name after selecting the display window to start the live view.

Live View Toolbar:

On the Live View page, the following toolbar buttons are available:

- **Set View**: Set the screen layout mode. 4 types of screen layout modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.
- **Stop/Start Live View**: Stop/Start the live view of all cameras.
- **Capture**: Capture the picture in the live view process.
- **Start/Stop Recording**: Start/Stop the manual recording. The record file is stored in the PC.
- **Previous**: Go for live view of the previous page.
- **Next**: Go for live view of the next page.
- **Mute/Audio On**: Turn off/on the audio in live view.
- **Digital Zoom**: Enable/Disable the digital zoom function.
- **Full Screen**: Display the live view in full screen mode. Press ESC to exit.

PTZ Control Functionality

Purpose:
Cameras with the pan/tilt/zoom functionality can be controlled through the web browser. You can also set the preset, patrol and pattern for the cameras.

Click the icon to expand the PTZ Control panel on the Live View page.
Configuring the Preset

Perform the following steps to add a preset:

1. Click the Preset button to enter the PTZ preset configuration panel.
2. Click the direction buttons to steer the camera to the desired view.
3. Select a PTZ preset number from the preset list and click the icon.

To call a configured preset, select the preset from the list and click the icon. To delete a configured preset, select the preset from the list and click the icon.

Configuring the Pattern

1. Click the Pattern button to enter the PTZ pattern configuration panel.
2. Click to start recording of this pattern path.
3. Use the direction buttons to control the PTZ movement.
4. Click to stop and save the pattern recording.
5. Click the icon to call the pattern. To stop calling the pattern, click.

Note: Only one pattern can be configured, and the newly-defined pattern will overwrite the previous
pattern.

![PTZ Control UI]

**Configuring the Patrol**

**Before you start:**
Two or more presets for one camera need to be added.

Perform the following steps to add and call a patrol:

1. Click the **Patrol** button to enter the PTZ patrol configuration panel.
2. Select a track number from the drop-down list.
3. Click ![Preset button] to add a preset, and set the dwell time and patrol speed for the preset.
4. Repeat the above operation to add other presets to the patrol.
5. Optionally, you can click ![Edit button] or ![Delete button] to edit or delete the preset in the patrol path.
6. Click the ![Play button] to call the patrol. To stop calling the patrol, click ![Pause button].

**Notes:**
- Up to 16 patrols can be configured.
- The preset dwell time can be set to 1~255 sec, and the patrol speed can be set to level 1~40.
### Video Settings Functionality

**Purpose:**
The video parameters, including the brightness, contrast, saturation and hue, can be configured to create better visual effects.

**Steps:**
1. Click the icon to expand the Video Settings panel on the Live View page.
2. Move the slider to adjust the brightness, contrast, saturation or hue of the live video.
3. Click Default Value, and you can restore the defaults of the video parameters.

![Video Settings Panel](image)

### 10.4 Playback

**Purpose:**
The record files stored on the storage devices such as the HDDs, Net HDDs and SD/SDHC cards on the local device can be searched and played back remotely through the web browser.

Click the **Playback** tab to open the Playback page.

![Playback Page](image)

**Playback Toolbar:**

On the Playback page, the following toolbar buttons are available:

- **Set View**
  - Set the screen layout mode. 4 types of screen layout modes are
selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.

Stop/Start Playback  Stop/Start the playback of all channels.
Capture          Capture the picture in the playback process.
Start/Stop Clipping  Start/Stop clipping the record files.
Mute/Audio On     Turn off/on the audio in playback.
Full Screen      Display the playback in full screen mode. Press ESC to exit.

Searching Record Files

Steps:
1. Open the Playback page.
2. Select the cameras to be searched from the list.
3. Click the icon to specify the start time and end time for the search.
4. Click Search. The record files of the selected cameras will be displayed on the Search Result tab page.

Notes:
- You can also search the record files by the card number (only applicable to ATM DVR) or by the file type.
- Up to 16 cameras can be searched simultaneously.

Playing Back Record Files

After searching the record files, you can play back the record files in the following two ways:

- Playback by File List
  Select the record file from the search result list, and then click the icon to play the video on the display window of playback.
- **Playback by Timeline**

The timeline indicates the time duration for the record file. Click on the timeline to play back the video of the specific time.

You can click or to scale up or scale down the timeline bar.

You can use the mouse wheel to zoom in or zoom out on the timeline.

Move the mouse pointer to the display window in playback to show the toolbar.

**Toolbar in Each Playback Display Window:**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pause/Start Playback" /></td>
<td>Pause/Start the playback of the record files.</td>
</tr>
<tr>
<td><img src="image" alt="Stop Playback" /></td>
<td>Stop the playback of all cameras.</td>
</tr>
<tr>
<td><img src="image" alt="Speed Down" /></td>
<td>Decrease the playback speed of the record files.</td>
</tr>
<tr>
<td><img src="image" alt="Speed Up" /></td>
<td>Increase the playback speed of the record files.</td>
</tr>
<tr>
<td><img src="image" alt="Single Frame" /></td>
<td>Play back the record files frame by frame.</td>
</tr>
<tr>
<td><img src="image" alt="Download" /></td>
<td>Download the record file for backup.</td>
</tr>
</tbody>
</table>
10.5 Account Management

*Purpose:* Different user accounts can be added for the client through the web browser and you can also assign permissions for the added users. The user you registered is set as the super administrator.

Click the **Account Management** tab to open the Account Management page.

![User List](image)

### Adding the User

**Steps:**
1. Open the Account Management page.
2. Click **Add** to open the Add User dialog box.
3. Select the user type. You can set the user type as Administrator or Operator.
4. Input the user name, password and confirm password as desired.
5. Check the checkboxes to assign the permissions for the created user.
6. Optionally, you can click **Default Permission** to restore the default permissions of this user.
7. Click **Save** to save the settings.

**Notes:**
- A user name cannot contain any of the following characters: `/\:*?"<>|`. And the length of the password cannot be less than 6 characters.
- Up to 50 user accounts can be added for the client software.
Managing the User

**Purpose:**
The newly created user account is added to the user list. You can edit or delete the information of the user accounts.
To edit the information of the user, select the user from the user list, and click **Modify**.
To delete the information of the user, select the user from the user list, and click **Delete**.

10.6 System Configuration

**Purpose:**
The general parameters, including network performance, play performance and saving paths of files can be configured through the web browser.

Click the **System Configuration** tab to open the System Configuration page.

![System Configuration Page]

**Steps:**
1. Open the System Configuration page.
2. Set the network performance and play performance. Click the icon to select a local saving path for the files. For details, see **Table 10.1 System Parameters**.
3. Optionally, you can click **Default Value** to restore the defaults of all system parameters.
4. Click **Save** to save the settings.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Performance</strong></td>
<td>The current network conditions. It can be set as Normal, Better or Best.</td>
</tr>
<tr>
<td><strong>Play Performance</strong></td>
<td>The play performance of the live video. It can be set as Shortest Delay, Real Time, Balanced or Fluency.</td>
</tr>
<tr>
<td><strong>Saving Path of Video Files</strong></td>
<td>The saving path of video files recorded by manual recording.</td>
</tr>
<tr>
<td><strong>Saving Path of Pictures</strong></td>
<td>The saving path of the captured pictures in live view or playback.</td>
</tr>
<tr>
<td><strong>Saving Path of Configuration File</strong></td>
<td>The saving path of the system configuration files.</td>
</tr>
</tbody>
</table>
Troubleshooting

Live View

Problem:
• Failed to get the live view of a certain device.

Possible Reasons:
• Unstable network or the network performance is not good enough.
• The device is offline.
• Too many accesses to the remote device cause the load of the device too high.
• The current user has no permission for live view.
• The version of the client software is below the needed version.

Solutions:
• Check network status and disable other not in use process on your PC.
• Check the device network status.
• Restart the device or disable other remote access to the device.
• Log in with the admin user and try again.
• Download the client software of the latest version.

Recording

Problem:
• Local recording and remote recording are confused.

Solutions:
• The local recording in this manual refers to the recording which stores the record files on the HDDs, SD/SDHC cards of the local device.
• The remote recording refers to the recording action commanded by the client on the remote device side.

Playback

Problem:
• Failed to download the record files or the downloading speed is too slow.

Possible Reasons:
• Unstable network or the network performance is not good enough.
• The NIC type is not compatible.
• Too many accesses to the remote device
• The current user has no permission for playback.
• The version of the client software is below the needed version.

Solutions:
• Check network status and disable other not in use process on your PC.
• Directly connect the PC running the client to device to check the compatibility of the NIC card.
• Restart the device or disable other remote access to the device.
• Log in with the admin user and try again.
• Download the client software of the latest version.